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Chapter 1 – Foreword
DeskArtes  Expert  Series  software  suite  consist  of  several  software  modules: 
3Data Expert, 3Data Expert Lite, Dimensions Expert, Sim Expert, Design Expert 
and View Expert.  The software  suite  covers  everything  from 3D CAD design 
through photo realistic renderings and CAD viewing to STL/VRML data transfer  
for 3D printing, Additive Manufacturing and simulation software packages. 
DeskArtes  3Data  Expert  9.1:  STL  and  VRML  Repair  Examples document 
describes the use of the latest improvements done for the faceted model repair  
with the Expert Series software. The use of the commands will be shown through 
several examples and most commands for faceted model repair are covered in 
the document:
- Fix Model > Verify Shells and Repair Shells commands for automatic model 

verify and repair,
- Fix Model >  Edit Triangles command for manual model editing,
- Modify Faceted > Boolean and Multiple Join commands for part combination 

and cutting,
- Great Geometry  > Extrude Surface to add material on surfaces, 
- STL, VRML and ZPR output for 3D printers,
- and several other supporting commands.
The examples contain both STL and VRML models. The shown techniques will 
apply to any STL, VRML and ZPR model similarly because all are used to define 
faceted (i.e. triangulated) models. The repairing of STL, VRML and ZPR models 
is  identical,  the  only  difference  is  the  additional  color  and  texture  handling 
available for VRML and ZPR models. New textures and colors can be added on 
any faceted model with 3Data Expert. 
Most of the examples will require the use of the 3Data Expert software equipped 
with full set of repair, manipulation (repair, boolean, extrude, edit triangles, …) 
and texturin/coloring  commands for triangulated models.
The  repaired  models  include  models  with  variable  level  of  difficulty.  These 
models are selected due to the errors in them. Normally you should not meet 
model with such large amount of errors if designed and outputted correctly from 
the sending CAD system. The models include a cell phone, a human head and 
Maya  demo part  are  included  in  the  installation  package  tutorials/GeomFiles 
directory. 
All commands and their parameters are explained in detail in the On-line Help of  
the  Expert  Series  software.  If  in  doubt  please  check  the  meaning  of  each 
parameter from the On-line Help.
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If you are using Expert Series the first time, you should reserve about four hours 
to go through all examples.
The operations given in  boldface in this document are commands which affect 
the geometry of the part in question and must be run by the user in the given 
order to get the results show in this document. Several other commands, like 
viewing and clipping, are not given in boldface but must be used to be able to  
generate a correct result. Terms given in italics indicate file names, commands, 
shell names, surface names and parameters for different commands. 
The full set of tutorials for Expert Series include and it is recommended to go 
them through in the given order: 

● Expert Series 10.0: Quick Start Guide  gives a short introduction to model 
repair and splitting for 3D Printing with 3Data Expert, 3Data Expert Lite 
and Dimensions Expert products. Estimated completion time 15 minutes.

● Expert Series 10.0: Tutorial 1 – Working with 3D Models introduces basic 
viewing,  measuring,  automatic  repair,  split,  connect,  hollow,  offset,  3D 
Text,  Boolean,  cut,  reduce,  surface  triangulation  and  other  model 
manipulation functions available for STL files. Applies to All Expert Series 
modules. Estimated completion time is 3 hours. 

● 3Data  Expert  10.0: Tutorial  2  –  Working  with  Colors  introduces  basic 
automatic repair and coloring for 3D Color Printer users. For 3Data Expert 
only. Estimated completion time is 60 minutes. 

● Expert Series 10.0: STL and VRML repair examples document includes 
more  advanced model  repair  operations with  3Data  Expert.  Applies  to 
3Data Expert module and mostly to 3Data Expert Lite, Dimensions Expert 
and Sim Expert modules. Estimated completion time with 3Data Expert 2 
hours. 
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Chapter 2 – The cell phone model
The first model to repair is a cellphone model (tutorials/GeomFiles/cellphone.stl) 
You will need the 3Data Expert, 3Data Expert Lite or Sim Expert to complete this 
exercise in about  10 minutes.  You can also use Dimensions Expert  until  the 
paragraph  Combining  the  cellphone  components  at  page  25,  which  requires 
Boolean commands. 
Green box indicates if the lesson is applicable to the given module:

View Dimensions Lite 3Data Sim

Now 
– input the STL file with File > Open command you can see the model 

on the graphics area.
For each inputted file the software will ask for the units if not available in the input 
file. 

– Select default Millimeter units and press OK:

:  
When the units are set the software will ask for the Operation Mode:
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Operation  Mode  Window  gives  a  reminder  on  the  possible  modification 
processes you can perform on a faceted model and allows you to select the 
correct set of tools for any operation. Note: if you do not see the Operation Mode 
window, please make sure the Show operation mode dialog when opening a file 
is On in the Edit > Preferences General Tab: 

The differences in the triangle colors on the display (blue vs. pink) are due to the 
fact that the triangle normals are not consistently oriented. The blue colors marks 
the inner side (inverted normal) and pink color marks the outer side (normal) of 
the triangles. 
Accept 

– Fix  Model  mode and  let  the  software  run  until  you  will  see  the 
following message:
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This is the result of the automatic analysis before the Auto Repair (the same 
result can be achieved through Fix Model > Verify Shells command if Operation 
Mode Window is not used). 
We can see that most of the 210 shells are separate from each other (red gap 
curves) but obviously should be connected into one single shell. It is up to taste 
either to run the Auto Repair with this model as the open flat shells are left non 
repaired for more controlled repair operations (to stitch with neighboring shells) 
later. Anyhow, running Auto Repair may generate solid shells from shells which 
should be connected to neighboring shells. 

Now 
– Press  No to  the  Do  you  want  to  run  Auto  Repair question.  After 

pressing No the status dialog appears:
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This indicates that most shells have errors and we should use Model Tree and 
Help Text to repair the model. 

– Press OK to close the window.
You may see the Command Tip window (if not seen give the command Help > 
Show Command Tips before running the analysis again): 

The Tip window gives useful information after different commands. For example, 
this tip window proposes to use the Fix Model Help Text window as well as visual 
checking to decide the next repair actions. 

– Press Close when ready reading the tip.
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The  analysis  shows  that  the  part  is  made  of  many  (210)  non  connected 
components or shells. The first task will  be connecting these components into 
meaningful  part(s).  The repair  is started by visual inspection due to the large 
number of disconnected shells in the model. We can also see that some triangle 
normals are incorrectly oriented (blue inner side is displayed) and a surface is 
missing from the flat end of the part. 
After the verification the components are listed according to their surface area in 
the Model Tree. If you take a look at the end of the Model Tree and display the 
last component 210 (F4) on the screen and then the whole model you can see 
that this part is an very thin triangle stripe and thus 

– shell 210 can be deleted (this is not absolutely necessary but can be 
done for practice).

The  next  component  to  check  is  the  209.  The  component  209 is  already  a 
meaningful square surface needed to generate a  good part. 
With a short visual inspection we can also see that there are alt least two bigger 
open shells (or surfaces) that we can remove (shells 107 and 182). 

– Remove first the component 182:

Note: If you did not remove these open shells now, you would notice these error areas after the  
first Repair run and could use Undo to get back to delete and rerun the Repair. 

– Then remove the shell 107,  the gaps below the shell will be filled 
automatically later:
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You  may  find  more  surfaces  with  errors  (red  areas  indicating  overlapping, 
intersecting, duplicate etc.  triangles). You may sometimes remove more small 
shells or surfaces if you think are not needed when creating the correct model. 
Generally, very thin or flat surfaces can be removed, they will be fixed with gap 
stitching  and  gap  filling  later.  Anyhow,  with  this  exercise  we  will  remove 
remaining errors using the help of Fix Model > Locate Errors command later. 

Useful Toolbars

Before continuing the exercises you may want to turn on the Transform Toolbar:

and the Errors Toolbar:

and the Dimensions Toolbar:

All are turned on via the View > Toolbars menu and contain shortcuts to useful 
commands for repair. 

Repairing the cellphone for the first time

Now we are ready to run the first  Fix Model > Repair Shells command on the 
model to connect the separate shells (surfaces) into meaningful shell or shells. 
First 
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– select the shell  1 from the Model Tree wih LMB (left mouse button) 
and then select the last component  207 while keeping the  Sift button 
down.

This will create a multi-selection containing all separate components:

You may also select the Model Tree root All before running the command to get 
all shells selected automatically for the command. 
Now

– Run the Fix Model > Repair Shells command
As mentioned before, the first task is to connect or stitch the open shells into 
meaningful closed shells. For that we will use the Stitch gap function in the repair 
command  to  connect  disjoint  open  shells  (surfaces).  We  will  use  the 
automatically calculated default parameters values now, especially 

– make sure that the Multiselected shells form separate parts is not 
set,

this will ensure that the stitching is done between the edges of separate shells. 
Your parameter dialog should look as seen below before continuing:
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Flat open shells may be sometimes better to fix using Offset (or Join Gaps) to 
generate solid shells. Normal Auto Repair process does not try to fix flat open 
shell for that reason. But now we want to fix all shells we have selected i.e. stitch 
them to neighboring shells, so you make sure  “Repair flat/open shells too” is 
taicked and

– Press OK to start the command.
After a while the command finishes and the status is displayed (for the first shell).  
Now we have significantly fewer components left  in the Model  Tree, as seen 
below. The components are sorted in the order of decreasing area and the status 
of the last selected shell is displayed:
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– Press OK to close the status dialog.
You should have 6 shells in the Model Tree. 

– Now use the multi-selection in  the Model  Tree to  see each shell 
bounding box:

We have now manged to combine over 200 separate (open surface) components 
into 6 useful components. The next step is to repair each component separately 
to a correct STL file and then use the Boolean operations to form one final part.  
The next step is to first to repair each shell into green state and then use the 
Boolean commands to join them into one component. 
Note: if you have more than 6 shells in the Model Tree, you may delete the the 
small extra shells caused by overlapping surface areas in the model. 

Locating and removing errors in the body

Let's  now give  a  more  descriptive  name to  each component:  body,  cylinder, 
upbox1, upbox2, downbox1 and  downbox2. The first task is to repair the  body 
component:
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The body component has several errors due to the bad quality of the input data.
– Select the body shell now

After  selecting  the  body  shell  in  the 
Model  Tree,  the  Help  Text  window on 
the right hand side of the window gives 
a textual description on the errors. 
In the image above we can see the red 
areas  on  the  top  of  the  component, 
these  are  caused  by  the  other 
components  intersecting  the  body 
(cylinder). Also, in the image next page 
we can see areas which have both error 
triangles and  complex gaps caused by 
duplicate  and  overlapping  surfaces  in 
the original input model (if you removed 
more  duplicate/overlapping  surfaces  in 
earlier you may have less errors now). 

– give the command Fix Model > Locate Errors or press the shortcut

button.  You  will  see  the  Locate  Errors  dialog  appear  and  error  triangles 
highlighted in the body shell:
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The Locate Errors dialog gives  exact  information  on the  currently  highlighted 
error  triangle  (or  gap),  Current  error.  Also,  the  surface  containing  the  error 
triangle is automatically selected in the Model Tree, as can be seen in the image 
above. 
We will  now use the  Previous and  Next buttons to  find each area with  error 
triangles and use surface selection and deletion as well as Fix Model > Triangle  
Edit to remove or add triangles to enable correct fixing with the next call to Fix 
Model > Repair Shells command. We will not use the Delete button available with 
Locate Errors tool  this time,  now it  is  better  to  use the red error  triangles to 
indicate the error areas for surface selection and deletion. 

– Press  Next-> button in the dialog and you should see the following 
error fitted in the middle of the screen:

Page 16



Expert Series 10.0: STL and VRML Repair Examples

You can use the mouse wheel zoom to zoom closer/farther to the area pointed 
with the mouse and middle mouse rotation to change the view point.
This error area is caused by some overlapping surfaces in the model. You can 
have a more detailed explanation on each error (red) triangle in the screen by 

– clicking it with the right mouse button on the screen on an error 
triangle:
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Then 
– select  the  triangle  index  menu  item  21906:  overlapping,  

intersecting triangle (or similar) to get more detailed explanation on 
the error triangle:

The dialog appearing will  give more detailed information on the errors in  the 
clicked triangle. We will  follow the first help to remove triangles or surfaces to 
reduce errors. 
Let's now start deleting bad surfaces and triangles in the error area. When we 
delete small overlapping surfaces, the number of errors diminish and soon we 
will only have gaps which can to be fixed automatically. 
Make sure that

– the Selection Mode is set to Surfaces now:

You may turn on the shaded+wireframe view mode by pressing the       icon with  
the left mouse button (LMB) and also make sure the selected object bounding bo  
is displayed by clicking            icon. 
Then 

– click with the LMB (left mouse button)  on the middle of the error 
area

to get an error surface selected: 
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Then 
– give the command Edit > Delete to remove the bad surface or press 

the shortcut

button. Then reselect a new surface at the bad area. When removing surfaces 
always try to remove the smallest error surfaces at a given error area first. Also, 
you should try to remove surfaces surrounded with red gap curves first. You may 
need to click several times on the same mouse location to figure out how many 
small surfaces are laying in the same area. You will notice that the error status is  
updated after each deletion:
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Now
– repeat  selection  and  delete  combination until  all  overlapping 

triangles are removed:
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A gap or gaps are left in the error area. These gaps will be fixed during the next 
run to the  Repair Shells command done later. Now we will go through the rest 
remaining error areas to perform similar bad overlapping or intersecting surface 
removal. 
You can easily find the next error area by pressing the Previous or Next buttons  
in the Locate errors dialog. Or you can select the next area visually. For example 
you can select the following surface in the middle section of the part: 

You will  need to remove two small error surfaces in this are to get the result 
suitable for subsequent automatic repair shells command, i.e. model with small  
gaps: 
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Now go to the next error area:

Select and remove surfaces until you have removed all bad surfaces in the area. 
You may also generate a larger gap at the area but do not worry, this will be filled 
with subsequent Repair Shells command:

There is still one area with red triangles around. The body – cylinder intersection 
has created red triangles on top of the body part.  If  you use the right mouse 
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button on top of the red triangles you will see the error status. This indicates that  
the error should be removed by using boolean operation between the body and 
the cylinder:

You can close the Locate Errors dialog now. 

The Boolean operations will be done after each shell is fixed into a correct STL 
shell. Now we will 

– select the body shell and
– run  Fix  Model  >  Repair  Shells command  on  to  fill  in  the  gaps 

generated during the surface removal. 
You can use automatically proposed parameters:
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- Press OK to start the command.
 After the command is run we have a body shell without any errors:

If you had problems producing the correct body, you can continue with the file 
tutorials/GeomFiles/cellphone-body-repaired.3de  stored  in  the  distribution 
package. 
Note: If you are still left with some errors and seem not to get forward, you may try the Fix Model  
> Edit Triangles command to remove individual triangles from areas with errors. Just start the 
command, click on triangles with LMB and finally RMB to remove them to make clean gaps for  
the automatic  gap filling with Repair Shells command. 

Repairing the small cellphone components

Now  we  will  have  a  look  at  the  remaining  cellphone  components,  cylinder, 
upbox1,  upbox2,  downbox1 and  downbox2.  Before  we  can  use  Boolean 
operations  to  combine  them  into  the  body  we  need  to  make  sure  that  the 
components are correct. We will use multiselection on shells 1 to 5:
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and run Fix Model > Repair Shells on all of them with the following parameters. 
Especially, the Multiselected shells form separate parts should be set On to keep 
the names for the results correct (and to avoid trying to stitch them together): 

The result is 5 correct components:
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Combining the cellphone components

The Modify Faceted > Boolean command is used to combine the 6 components 
into one correct STL file. You will need 3Data Expert, 3Data Expert Lite or Sim 
Expert to finish the cellphone example as Dimensions Expert does not include 
Boolean commands. 
First we will  combine the  cylinder with the  body. As we can see in the image 
below (using clipping with       icon) the two components are slightly intersecting: 

We can  connect  these  two  shells  into  one  just  by  using  Modify  Faceted  > 
Multiple Join or with  Modify Faceted > Boolean command. We will use Multiple 
Join command. 

– Select the shell 1. body and shell 6. cylinder as shown in the image 
above.

– Give command Modify Faceted > Multiple Join

Soon you are asked to Remove original parts:

– Press Ok  to  Remove original  parts  and to  commence the Boolean 
operation.
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Soon the result will appear, the two shells are connected and the result is stored 
in a new shell, body (Multiple Join):

Now we will connect the upbox1 and upbox2 shells to the body. The fixtures are 
too  far from the body, so we either need to move them towards the body or we 
need to generate extra material on the surfaces facing the body. Now we will  
generate more material  on the surfaces.  Extra material  is  added with Create 
Geometry > Extrude Surface > from Surface command. 
Note:  With 3Data Expert  Lite or Sim Expert  you can use the Transformation  
commands to move the fixture shells slightly  (0.01 mm) towards the body shell. 
With 3Data Expert we will add material on the upbox1 shell, selected below in the 
Model Tree:

To be able to create a boolean result, we will add material to the surface facing 
the body shell.  

– Fit the shell with LBM +        icon
– make sure you are in the Surface selection mode:
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– Then rotate eye point to see the surface facing the body shell
– and select surface graphically

Then 
– give  the  Create  Geometry  >  Extrude  Surface >  from Surfaces 

command
You will see the following parameter dialog: 
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– fill  in  the  values  above (thickness 0.01  mm  and  untick the  use 
default)

– press OK
After a while you will see the extrude result:

The command moves the selected surface to the (average) normal direction of 
the selected surface(s) and creates new edge triangles to keep the fixture solid. 
Now 

– use the multi-selection (Ctrl  +  LMB)  to  select the  body and the 
upbxo1 shell

– give the command Modify Faceted > Multiple Join and press OK 
(twice):
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The result now has the two shells connected into one shell  4. body (Multiple 
Join). Connect the upbox2 shell to the body in similar fashion, 

– select the surface facing the body
– extrude  material  with  Extrude  >  from  Surface with  the  same 

parameters used in the previous extrude
– run Multiple Join to connect the shell to the body

After connecting the upbox2 shell you should have the following composition in 
the Model Tree:

In the last Boolean step we will  connect the  downbox1 and  downbox2 to the 
body. 

- Use multi-selection to select all three shells
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If  you  do  some  visual  checking  with  Clipping  tool,  you  will  see  that  the 
components are tangential:

The new Boolean operations with Expert Series software can most of the time 
handle tangential surfaces, i.e. to connect them correctly. Just proceed with 

- command Modify Faceted > Multiple Join for the three shells
After a while you will see the three shells connected into one body shell:
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The correct model is stored in the cellphone-repaired.3de file in the distribution 
package.  

Transferring to 3D Printing via Plugin

You  amy  want  to  use  the  Print  Preparation  menu  plugins to  transfer  the 
cellphone model directly to another Additive Manufacturing application, like some 
3D Printer control software.
To define and use plugins from Expert Series software products, please see On-
line Help Menus and Commands  > Print Preparation > New Plugin page. This 
page  explains  how  to  create  connection  to  3D  Systems  ZPrint,  Stratasys 
CatalystEX and Objet Studio software products, for example. 

Conclusions with the cellphone model

The cellphone model can be repaired using the Expert Series software within 5 -  
10 minutes by an experienced user. Stitching gaps, adding material and using 
Boolean allow us to fix the cellphone file in a few minutes. The output result is a 
fully fixed STL model for 3D Printing or Additive Manufacturing. 
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Chapter 3 – A human head
The  second  example  will  be  a  VRML model,  a  human  head,  file  tutorials  /  
GeomFiles  /  gary_front_profile_bwrl.wrl in  the  example  package.  The  head 
model  can be repaired using 3Data Expert,  3Data Expert  Lite  or  Sim Expert 
modules  with  less  than 5 minutes.  The extensive  use of  Boolean operations 
make this example unsuitable for Dimensions Expert. 
Green box indicates if the lesson is applicable to the given module:

View Dimensions Lite 3Data Sim

Anyhow,  Dimensions  Expert  can  be  used  until  paragraph  “Repairing  and 
combining the head and the eyes”. You may also want to try the self-intersection 
removal in paragraph “Repairing and combining the head and the teeth” on page 
44 if running Dimensions Expert. 
Start by 

– inputting the VRML file  gary_front_profile_bwrl.wrl with  File > Open 
command

you can see the model on the graphics area. For each inputted file the software 
will ask for the units if not available in the input file. 

– Select Millimeter units and press OK.
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When the units are set the software will ask for the Operation Mode:

Analyzing the head model automatically

We will now 
– select the Fix Model mode, this will automatically analyze the model 

for errors as well as orient the normals consistently.
After a while the analysis result is shown: 

After the analysis the surface normals are corrected and the outer surface color 
is changed to pink, the inner surface color remains light blue. 
The model has 6 shells each with errors. 

– Press OK to close the dialog and
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to see the Model Tree and the Tools Window with Fix Model Tab and repair Help 
text  window.  The  software  asks  you  if  you  wish  to  run  the  Auto  Repair 
immediately:

The visual inspection of the errors (gaps) in the model suggest that we should 
not run the Auto Repair. Auto Repair will repair each open shell (6) separately 
into a solid shell.  The gaps in this model at the mouth /  lip region show that  
closing them may generate separate shells where shells should be connected to 
each other at open edges (lips vs. mouth). Anyhow, you may do a faster repair 
just by running the Auto Repair now and skipping to the chapter  Repairing the 
teeth on page 44. 

– Press  No Auto  Repair  to  start  a  more  careful  examination  of  the 
errors.

You will see the status window appearing:
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This indicates that each shell has errors and we should use Model Tree and Help 
Text to repair the model. 

– Press OK to close the window and
to see the Command Tip window (if not turned off earlier): 

The Tip window gives useful information after different commands. For example, 
this tip window proposes to use the Fix Model Help Text window as well as visual 
checking to decide the next repair actions.

– Press Close when ready reading the tip.
Before going to more controlled use of the repair commands you may want to 
take a look at the real colors in the VRML file. For that you should turn on the 3D 
Color Printer mode for a second. Press the        icon to see the original VRML 
texture map colors: 
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3Data Expert can repair and manipulate fully colored and textured models for 3D 
Color Printing. Now press the       icon again to get back to the  Repair color 
mode. 

The Model  Tree on the left  hand side of  the 
display  area  contains  the  directory  to  the 
geometrical  information  for  the  model.  This 
model contains 6 shells (e.g. 1. gary_front_prof  
(Verified),  ...).  Each  shell  contains  Verified 
triangle  surfaces  (press  +-icon  to  see  the  1. 
Verified,  2.  Verified.  etc. surfaces  inside  the 
first  shell).  The  texture  information  for  the 
VRML data (.jpg images) is stored after each 
surface.

If you select each shell separately you will see that they represent the eyes, teeth 
and mouth for the head model. After the initial verification the shells are ordered 
by surface area in descending order. 
Now select different shells in the Model Tree and see the Help text window in the 
bottom of the Fix Help Tab on the right hand side of the screen. Select  the 1.  
gary_front_prof (Verified) shell with the left mouse button from the Model Tree:  
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The message in the Fix Model Tab Help 
text window tells that there are several 
intersecting  triangles (about  153)  and 
gaps (4) in the selected shell. Gaps are 
shown  as  red  curves  on  the  graphics 
area and stored in the Gaps element in 
the end of each shell in the Model Tree 
(for  example,  open  the  1. 
gary_front_prof  (Verified) component 
and use the vertical scrollbar to scroll to 
the  end  of  the  component  to  see  the 
Gap element). The intersecting triangles 
are show with  red color  in the display 
area.  The  are  mostly  generated  by 
intersections  between  the  eyes  and 
mouth parts with the 1. shell. 
Below the status information the set of 
possible commands to fix the model are 
presented. There may be one or more 
commands  and  the  first  is  the  most 
likely  action  to  take.  Anyhow,  you 
should  also  use  visual  inspection  to 
finally decide the command to run. 

The input file is divided into 6 different shells in the Model Tree; the original head 
consist of these disconnected components (eyes, teeth, mouth …). In the sequel, 
all gaps will be closed and the components will be connected into one correctly 
oriented part. 

Analyzing the head model visually

Some visual inspection very quickly shows us that the 1. shell (head) should be 
connected with the inner mouth shell (2. shell). In the image below the two shells 
are  displayed  (non  displayed  shells  are  grayed  out  in  the  Model  Tree)  and 
clipped to  display  the  inner  structure  of  the  model  (the  Clipping  Tab can be 
displayed by pressing the         icon): 
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We can use different visual aids to define the order how to fix and combine the 
different  components  together  (see  the  image  above).  Several  viewing 
commands  are  available  in  the  View menu as  well  as  the  Viewing  Tab  and 
Clipping Tab functions do determine the best way to go forward. For example, we 
can have a look at the model using clip form +X direction and a thick light blue 
clip curve, as seen above. 
Investigating the verified model visually will show us that one possible way to go 
is to repair and combine the parts in the following order:
1) stitch head and mouth into one correct shell
2) repair eye shells
3) repair teeth shells
4) join all shells with Multiple Join command into one shell

Before starting the repair operations, lets
– rename the different shells with more descriptive names

with right mouse popup menu on the Model Tree item + Rename command. This 
will  help  us to  keep better  track on different  parts  during the repair  process. 
Below we can see the renamed components. 
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Repairing and combining the head and the mouth

With the head and the mouth we will  use the automatic  Fix Model  > Repair  
Shells command to combine the mouth to the head at the lip area. Stitching the 
mouth edges into the lips (see below) will produce a desirable result.

We can see that both the disjoint shells are more or less at the same distance 
from  each  other  along  the  open  edge.  The  approximate  distance  can  be 
measured  using  the  Dimensions  >  Distance command  and  it  will  give 
approximately 0.05 units (you can also use the         icon to start the Distance 
command). 
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Before running the  Fix Model > Repair  
Shells command we will  use  the  multi 
selection  (Ctrl +  left  mouse  button 
(LMB))  to select  both  head and  mouth 
components in the Model Tree. 

Now 
– select the two shells with  multi-selection, first the  mouth,  then the 

head (the last selected shell will give the name to the result)
– run the Fix Model > Repair Shells command from the menu or use 

the command Fix Model Tab shortcut

button. You will see the following parameter window:

To  get  good  results,  we  must  give  correct  parameter  values  for  the  repair 
process. As seen above, normally we want  Check for triangle errors as we are 
changing the geometry and we want to know the possible errors after the repair. 

- Turn Off the Multiselected shells form separate parts setting. 
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Stitch gaps smaller than 0.071345  is automatically calculated according to the 
size  of  the  selected  shells.  According  to  our  measurements  earlier  this  will 
connect  the shells together  by stitching the edges together,  i.e.  all  segments 
which are closer than  0.071 units from each other will  be combined.  Fill gaps 
smaller than and value All will fill the remaining large gaps (neck and eye slots) to 
form a solid model. 
Note: you must be careful when filling the Stitch gaps smaller than value. If a too large value is 
given some edges may be connected to edges too far away, causing new errors. 

The Advanced parameters are not needed with this example. 
With the head model we will accept the default parameters seen in the image 
above and 

– press OK to start the Repair Shells command
After a while we will see the correct result and the message

The original  parts  will  be deleted from the Model  Tree and the result  will  be 
stored in the end of the Model Tree, 5. mouth (Repaired) (should be renamed to 
head immediately). 

– Press OK to close the message dialog

Repairing the eyes

In the next step we will repair the eye ball shells to prepare for combining them 
with the head shell later in the process. 
First we will 

– select both eye shells, left eye and right eye,
for the second Fix Model > Repair Shells command. The selected sells are fitted 
on the graphics area in the image below: 
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– Give the command Fix Model > Repair Shells 

The parameter dialog is displayed. 
We will use the default parameters except that we will 

- set the Multiselected shells form separate parts to On 
as we do not intend to join the two eye balls with each other (they would be too 
far from each other in any case):

– Press OK to run Repair Shells command
– Press OK to close the following status dialog

And you will see two correct eye balls in the end of the Model Tree:
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Repairing the teeth

In the next repair the teeth shells to be connected to the head shell later. First we 
will run  Repair Shells command individually on both teeth set,  upper teeth  and 
lower teeth, to get a solid STL data for the following Boolean operations. 

– Select the upper teeth shell and
– run the Fix Model > Repair Shells on the selection.  

Use the automatic parameters.  Note:  Repair Shells is the second preferred command in 
the Help Text window in the Fix Models tab (first proposal Join Gaps can not be used as there are 
no similar gaps close by).

– Press OK to start the Repair Shells command

After a while you will see the result
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The software reports 23  Intersecting triangles error. A closer investigation (red 
triangles  in  the  image  below)  shows  that  the  intersecting  triangles  are  are 
piercing through the outer surface. 

In the Fix Model Tab Help text window the most recommended repair action is to 
run Remove Self-intersections command. 

– Run the  Fix Model > Remove Self Intersections command on the 
upper teeth shell now.

The command can also be started from Fix Model Tab shortcut 

button.  After a while the self-intersection result is displayed with Tip window, if  
not turned off earlier: 
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The Tip window indicates that the shells preselected after the command is run 
can be deleted. These are the small pieces generated by the self-intersection 
removal and can normally be deleted from the result; the largest shell is the one 
before the preselected shells and is normally the correct  result.  Anyhow,  you 
should always visually check that the correct extra shells are removed. With this 
example the visual check also supports the proposed removal of the shells 6 to 
10, as seen on the next image:

– Delete the extra shells with Edit > Delete command
or by pressing the Fix Model Tab delete shortcut 

button.
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The software  now recommends you  to  run the  Repair  Shells  to  fill  the  gaps 
generated during the Remove Self-intersections command. 

– Run  Fix  Model  >  Repair  Shells command  with  the  automatic 
parameters now to generate a solid upper teeth shell:

The lower teeth is handled in the similar manner. First 
– run the Fix Model > Repair Shells command to close all gaps

on  the  lower  teeth component  to  make  it  solid.  Once  again,  there  are  self 
intersecting triangles which are removed by 

– running the Fix Model > Remove Self-intersecting command.
After  the  self  intersection  removal  the  extra  small  shells  4  to  12  are  again 
deleted: 

– Delete the preselected small shells now.
– Run Fix Model > Repair Shells  on the shell 5. to create a solid shell.
– Press OK to close the status window
– give View > Fit for the root node All
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Now we will have a model with 5 correct shells to be connected into one final 
shell. 

Now we are ready to combine the three remaining components,  head, upper 
teeth and the lower  teeth into  one solid  STL part.  First  we  will  use  multiple 
selection to  select  all  parts  and then  run the Modify  Faceted > Multiple  Join 
command on them. 

– Multi-select all shells in the Model Tree and
– Run Modify Faceted > Multiple Join on the selected shells:

– Press OK to Remove original parts

A progress bar is shown for each shell to connect (1/5, 2/5, … 5/5) and soon you 
will see the correct head (if necessary, rename the mouth shell to head shell):
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The Fix Model Tab Help texts shows that the model is correct too: 

Outputting head STL and VRML files

The STL output of the file is straightforward, just select the model and give File > 
Save As command with the STL option. Also, outputting to 3D Color Printing can 
be done easily by selecting either VRML or ZPR file formats. 
The correct file  tutorials /  GeomFiles / head-repaired.3de can be found in the 
installation package. 

Page 49



Expert Series 10.0: STL and VRML Repair Examples

Chapter 4 – The Maya model
The  second  model  to  fix  will  be  a  test  part  generated  with  Maya  software 
(maya_three_d.wrl in the example package). The maya model fixing should not 
take more than 20 minutes with 3Data Expert or other Expert Series module. 
Green box indicates if the lesson is applicable to the given module:

View Dimensions Lite 3Data Sim

Start and
– Open the file maya_three_d.wrl with File Open dialog.

After the input we will immediately see that the model is not oriented correctly,  
there is a lot of blue inside (inverted normal) color visible amongst the material 
colors (normal side) inputted from the VRML file. 
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– Set the Units to Millimeters and press OK to continue to Fix Model 
mode:

– Press Fix Model to start the analysis and after while you will see the 
error message:

The normals are now consistently oriented and also the repair color is set to the  
normal sides of the triangles (the original material colors are stored for the 3D 
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Color Printer mode). There are also a few gaps visible on the screen. We can 
see that there are errors close to the “created with” text. Running Auto Repair 
may join the small details in the letters in a way which may cause difficulties later 
with the Boolean operations, so we will 

– press No to the Auto Repair question:

Familiar status message appears: 

– Press OK to close the window and also press
– Close to the Tip window appearing if set On through the Help menu. 

Now we will select the shell 1. maya_three_d (Verified) from the Model Tree and 
have a look at the Help text in the Fix Model Tab. 
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The  indicated  errors,  137  overlapping 
triangles are typically the most difficult to 
fix. This may require removing surfaces 
manually  and  then  adding  some 
triangles  to  help  correct  filling  for  the 
gap. Also, re-trimming of some surfaces 
against  each  other  is  sometimes 
required. 
The 10 intersecting triangles are either 
fixed  by  Remove  Self-intersecting 
triangles command or Delete triangles / 
Repair  Shells  pair.  Anyhow,  now  we 
must  first  remove  the  overlapping 
triangles  to  see  the  real  situation 
concerning the intersecting triangles. 
To start, let's rename the shell to shorter name, maya. If you now now open the 
Model Tree for the maya part, we can see no textures as was the case with the 
previous  head model.  Now the  model  colors  are  given  through  the  material 
definitions in the VRML file. 
You may now try to press the 3D Color Printer           icon to see the true colors 
of the model: 

Return to Repair color mode by pressing the          icon again before continuing.  
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Repair steps for the Maya model

The errors in the model are caused by erroneous triangulation of surfaces at the 
intersections of different model components. First you should investigate visually 
how serious the errors are. 
A short investigation reveals that we can not just delete the erroneous triangles 
with Fix Model > Delete Errors > All error triangles command. Instead, we need 
to do some 

1) The “created with” text requires to be re-connected to the part for correct 
STL/VRML file generation. 

2) The box below the “created with” is not correctly trimmed to the curved 
surface attached to it. 

3) Manual  triangle removal  and addition at  the string “graphics”  character 
borders to help the automatic repair to produce the correct result in the 
end.

4) Gaps should be filled with automatic repair.
Let's start with the worst problem, re-connecting the “created with” string. 

Connecint the “created with” string

The string “created with” needs to be re-connected to the maya shell first. If you 
take a look from X axis and use clipping, you will see that the text is on a flat  
surface.  In  this  case  we  can  use  the  new  flat  polygon  area  fill  functionality 
available with the Repair Shells command. In the clipped image below you can 
see that the gaps are on the flat plane:
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We will  first clean up the planar area surfaces the text is attached to. Before 
selection make sure the Selection mode is in the Surface selection mode:

Then
– take a view from X axis direction
– use Alt + LMB rubberband selection to select the surfaces in the flat 

plane as seen below

When the mouse is released, the surfaces at the plane are selected:

And from another view point:
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Then
- give Edit > Delete command to delete all selected surfaces

Now 
– select the maya shell
– give Fix Model > Repair Shells command to fill the gap between the 

text and the surrounding area
Soon you will see the parameters dialog:
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The  new  Flat  polygon  area  fill,  set  on  by  default,  will  connect  the  flat  gap 
polygons at the letter bottom edges to the surrounding box edges. All polygons 
lay in the same plane and the software use a special algorithm to fill between the 
separate polygons automatically. 

- press OK to run Repair Shells on the maya shell.
The result on the text area is a prefect triangulation between the letters and from 
the letters to the surrounding square gap. 
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Fast visual inspection to the result will show as that the “created with” string is 
correctly connected to the maya component. 

The maya model would be printable with 
any 3D Printing system with the current 
state.  Anyhow,  there  are  still  a  few 
overlapping and  intersecting triangles 
and  we  will  fix  them  for  the 
completeness shake in the sequel. Also, 
some  thin  triangles  may  have  caused 
inverted  surface  area  to  appear.  This 
will also be fixed in the sequel.

Repairing the text base box

To locate the remaining errors you can either look for the red triangles on the 
screen or use the Locate Errors command to highlight the error triangles with  
yellow edge color and to fit them on the middle of the screen. Locate Errors tool  
will help you to pinpoint any error triangle or gap in the model. 

– Give  Fix  Model  >  Locate  Errors command or  press  the  Locate 
Errors

button in the Fix Help Tab. 
The Locate Errors Tab is displayed and error triangles highlighted on the screen. 
The  dialog  will  give  info  on  the  total  number  of  errors  in  the  selected  shell,  
Previous and  Next buttons to select and fit the next error on the display area, 
error type for the currently selected error triangle as well as buttons to go to the 
next or previous Shell with errors

Page 58



Expert Series 10.0: STL and VRML Repair Examples

Press  the  Next button on  the  Locate  Errors  dialog  until  the  following  error 
triangle is highlighted on the scree: 

We will now clean up this overlapping triangle and the area surrounding it. You 
can 

– close the Locate Errors dialog now by pressing Close button.
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The box feature in the model has some overlapping triangles on the upper face,  
as seen in the image below: 

These errors can not be removed 100% reliably using automatic Remove Self-
intersections command due to the tangential intersection conditions. Now we will 
remove  a  few triangles  manually  and  then  let  the  Fix  Model  >  Repair  Shell 
command to Fill all created gaps. 

– Start triangle removal with Fix Model > Edit Triangles command or 
using the Fix Model Tab shortcut 

button.
Remove enough overlapping triangles from the error area, as seen in the next  
image.  You  could  also  use  Surface  selection  mode  and  LMB selection  with 
Delete to get rid of extra surfaces in the area. 
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To finish the fixing at the “created” string, have a look at the bottom of the base. 
– Select all red triangles and delete them also on the down surface of 

the box to allow the automatic repair to fill the gap correctly:

You may use the mouse wheel zoom and middle mouse rotation during the Edit 
Triangles command to get a better view to the delete triangles if necessary.  After 
the removal the gap should look as seen here: 

Page 61



Expert Series 10.0: STL and VRML Repair Examples

The run 
– Fix  Model  >  Repair  Shells command  and  the  corrected  area  is 

displayed:

Repairing the “graphics” string

To locate the last remaining errors we should use the Fix Model  > Locate Errors 
tool again. 

– Give the command  Fix Model > Locate Errors to open the Locate 
Errors dialog or press the Fix Model Tab shortcut
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button. Error triangles in the model will be highlighted with yellow color as seen 
on the image next page:

The last errors are at the letter 'c' in the graphics string. Press Next or Previous 
to zoom into the error area and the close the Locate Errors dialog. The errors 
around the letter 'c' are similar to the previous two errors we have fixed: 
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– Open Fix Model > Edit triangles tool and
– remove  the  overlapping  triangles  with  LMB  selection  +  RMB 

delete
The give 

– Fix Model > Repair Shells command  for a gap filling and you will 
have a correct maya model.

Note: You may find a new area or areas at the letter 'p' with similar errors after the last repair, just  
remove the  overlapping or intersecting  triangles in that case and rerun the Repair Shells once 
more. Or use  Fix Model > Edit Triangles to clean up the error triangles, simplify the gaps and 
rerun the Fix Model > Repair Shells until there are no errors. 

Outputting the Maya model

Once  again,  STL,  VRML and  ZPR output  is  straightforward  File  >  Save  As 
operation. 
The correct file tutorials / GeomFiles / maya_three_d-repaired.3de is available in 
the example package.
If your goal is to take the model to 3D Color Printing, you will need to fix some 
color errors created during the topology fixing. Model  coloring is described in 
detail in the “Working with Colors” (through the Help menu).
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Chapter 6 – Conclusions
Congratulations for reaching the end of this repair example document! By going 
through the examples you have learned a lot of the advanced STL and VRML 
model  fixing  functions in  the  DeskArtes Expert  Series  software.  The handled 
models are difficult and in the everyday work you should not need all the skills 
acquired to prepare parts to be build. Anyhow, when a difficult model comes you 
will now know what do with it!
We have shown that the DeskArtes Expert Series, especially the 3Data Expert 
can be efficiently used to fix even most difficult geometrical problems. Investment 
in  the  3Data  Expert  software  will  pay  itself  back  very  fast  due  to  increased 
throughput  of  the  3D  Printing  system  or  seamless  STL  model  transfer  to 
simulation softwares. New Expert Series Plugins allow you to connect to other 
software products with ease.  
There are still several other commands available in the DeskArtes Expert Series 
software suite for generating and handling triangle models. To know more about 
these commands we recommend you  to  go  through the example  documents 
available through the Help > Tutorial Documents command.
Thank you for spending you time with these exercises. We wish you pleasant 
and productive moments with the software in the future and also ask you not to 
hesitate  to  contact  us  at  DeskArtes  (support@deskartes.fi)  if  you  have  any 
questions concerning this manual or the Expert Series software in general. 
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